LAB MAESTRO – SIMULATOR APPLICATION GUIDE
Version 1.2

TABLE OF CONTENTS
Table of Contents ............................................................................................................................ 0
Table of Figures ............................................................................................................................... 1
Purpose of Simulator ...................................................................................................................... 4
Installation ...................................................................................................................................... 5
Licensing ...................................................................................................................................... 5
Welcome screen ............................................................................................................................. 9
Project management ................................................................................................................... 9
Creating new device .................................................................................................................... 9
Introduction to the graphical user interface ................................................................................ 10
Signal Viewer ............................................................................................................................. 11
Accessory Viewer ....................................................................................................................... 14
Device & Applications Settings .................................................................................................. 15
Digital Inputs ................................................................................................................................. 19
Accessory Configuration ............................................................................................................ 19
Digital Pulse / MRI trigger .......................................................................................................... 21
Digital Outputs .............................................................................................................................. 22
Pixel Mode ................................................................................................................................. 23
Analog Inputs and Outputs ........................................................................................................... 25
Analog Output (DAC) ................................................................................................................. 25
Analog Input (ADC) & Waveform Generator ............................................................................. 25
Audio ............................................................................................................................................. 27
Differences between real and simulated device .......................................................................... 27
Register / Memory / Clock / Timetag ........................................................................................ 27
Schedules ................................................................................................................................... 28
“Video” and Refresh Rate .......................................................................................................... 28

LM Simulator Application Guide

1

VSync / PSync Synchronization .................................................................................................. 29
Loopback.................................................................................................................................... 31
Integration with API ...................................................................................................................... 31
Eye Tracker and Future Plans........................................................................................................ 31
Annex - License Management....................................................................................................... 32
Inviting New Users ..................................................................................................................... 33

TABLE OF FIGURES
Figure 1 Simulator Sign in Screen ................................................................................................... 6
Figure 2 License information at the bottom of the screen............................................................. 7
Figure 3 Information for Bronze Edition during trial, and after trial ends ..................................... 7
Figure 4 The About screen Sign In and Sign Out buttons ............................................................... 8
Figure 5 Trial license ended pop-up................................................................................................ 8
Figure 6 Welcome Screen ............................................................................................................... 9
Figure 7 Interface for a newly created device .............................................................................. 10
Figure 8 RESPONSEPixx Tab .......................................................................................................... 11
Figure 9 Signal Viewer................................................................................................................... 12
Figure 10 Signal Selection ............................................................................................................. 13
Figure 11 RESPONSEPixx Handheld .............................................................................................. 14
Figure 12 Application Settings ...................................................................................................... 15
Figure 13 Device Settings .............................................................................................................. 16
Figure 14 Pixel Mode .................................................................................................................... 17
Figure 16 Pixel Sync Settings ......................................................................................................... 18
Figure 17 Accessory Selection....................................................................................................... 19
Figure 18 Properties IO Configuration .......................................................................................... 20
Figure 19 Digital Output Properties .............................................................................................. 22
Figure 20 Pixel Mode Settings....................................................................................................... 23
Figure 21 Pixel Mode ON .............................................................................................................. 24
Figure 22 Analog Input Properties ................................................................................................ 26
Figure 23 Device Settings – Video Refresh Rate ........................................................................... 28
Figure 24 Pixel Sync Mode Settings .............................................................................................. 30
Figure 25 Log In Interface to Manage Licenses ............................................................................ 32
Copyright © 2021 VPixx Technologies Inc. All Rights Reserved

LM Simulator Application Guide

2

Figure 26 Organization Administration......................................................................................... 33
Figure 27 The Licenses Page ......................................................................................................... 33
Figure 28 Steps to Invite a New User ............................................................................................ 34

Copyright © 2021 VPixx Technologies Inc. All Rights Reserved

LM Simulator Application Guide

3

IMPORTANT
VPixx Technologies Inc. reserves the right to modify or otherwise update this document without notice as required by a constantly evolving
marketplace, client requests or to adapt to new progress or constraints in engineering or manufacturing technology. The information contained
in this document may change without prior notice. No part of the written material accompanying this product may be copied or reproduced in
any form, in an electric retrieval system or otherwise, without prior written consent of VPixx Technologies Inc.
Product/company names mentioned in this document are the trademarks of their respective owners. DATAPixx, DATAPixx2, DATAPixx3, LM
Simulator, PROPixx, PyPixx, RESPONSEPixx SOUNDPixx, TOUCHPixx, TRACKPixx, TRACKPixx3, TRACKPixx /mini, TRACKPixx /MRI, VIEWPixx,
VIEWPixx /3D and VIEWPixx /EEG are registered trademarks of VPixx Technologies Inc. Python, MATLAB and any other referenced product names
and/or logos are trademarks of their respective owners.
For more information about our company and products, visit our Web site at www.vpixx.com
For information, comments or suggestions, please contact us by e-mail at support@vpixx.com
Our offices are located at:

630 Clairevue West suite 301
Saint-Bruno, Qc
Canada, J3V 6B4

Version History of this document
Version Updated
to

Date

Author

Reason

0.1

2020/12/10

D.Michaud

V0.1 created

1.0

2021/02/15

P.Kakos

Format update and text review

1.1

2021/04/23

D.Michaud

Format update and PSYNC update

1.2

2021/07/04

D.Michaud / S.Pelletier Eng.

Simulator version 1.1 update

Document Icons
The use of icons emphasizes helpful, caution or warning notes.
Icon

Description

Helpful Hint

Caution Notice

Description

Information to help out during assembly, installation or usage

Important Information to prevent misuse and/or damage to equipment

Copyright © 2021 VPixx Technologies Inc. All Rights Reserved

LM Simulator Application Guide

Warning

4

Critical information to prevent damage to equipment and/or injury to personnel or
participants

PURPOSE OF SIMULATOR
The LabMaestro – Simulator (abbreviated Simulator) is a software program made to test, write
and preview experiments intended to be run on VPixx Technologies hardware. Once the
Simulator is started, any software that would normally communicate with VPixx devices will
communicate with the Simulator. Also, the simulator will act as a virtual device, behaving as if
the code was running on a real device.
In the context of an expensive fMRI installation as well as in any normal laboratory environment,
there is usually contention between developers writing or modifying new paradigms and the
researchers or students trying to schedule subjects for their experiments. The simulator allows
programmers to develop and test their code at alternate locations, away from the lab hardware.
This has added value if developers work remotely from home, or while attending a conference,
and offers VPixx Technologies customers the opportunity to develop in the absence of VPixx
hardware.
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INSTALLATION
The installation of the LM Simulator is the same as the installation for the VPixx Software Tools.

LICENSING
There are three types of licenses currently available: Bronze, Silver and Gold. The following table
shows the features included with each license type.

Features

Bronze

Silver

Gold

Digital Inputs
Digital Outputs
Schedules
RESPONSEPixx (Non-MRI)
Analog Inputs
Analog Outputs
Audio Output
Pixel Mode
Video & Pixel Sync
Signal Viewer
RESPONSEPixx MRI
Signal Generator
Eye Tracker
The Silver and Gold licenses are paid licenses, while the Bronze license is free to use. To purchase
a license, contact the VPixx sales team.
You can access a FIVE (5) minutes Gold features by clicking the Trial Gold button on
the login screen. During this time, you can see everything available in the Simulator.
After the trial period (5 minutes) is over, access to the features is no longer
available.
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To enable your license, the welcome page allows you to log into your account. Your license will
be activated once the purchase order has been processed. Refer to the next section for
information if you are a license manager in your organization.

Figure 1 Simulator Sign in Screen

<1> Your email address for the my.vpixx.com account
<2> Your password for the my.vpixx.com account
<3> If you need to create a new account, or if you have forgotten your password.
<4> If you wish for the program to remember your login info (you can always log out later)
<5> Sign in to the current account
<6> Gold Trial button

Once you are logged in, you can see the current license in use at the bottom of the program:
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Figure 2 License information at the bottom of the screen

If you enter the Gold Trial, you will see a warning relative to the trial and the time remaining.
You can visualize the time remaining at the bottom of the screen as well:

Figure 3 Information for Bronze Edition during trial, and after trial ends

If you wish to log back in after starting a trial, or log out to change account, you can access
these buttons via the Help -> About menu:
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Figure 4 The About screen Sign In and Sign Out buttons

After the trial period has ended, a pop-up will inform you of your current license level:

Figure 5 Trial license ended pop-up
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WELCOME SCREEN
After logging in, you will be brought to the Simulator’s Welcome screen. On this screen, you can
create a new project, select a recent one or load a custom VPDS.

Figure 6 Welcome Screen

PROJECT MANAGEMENT
VPDS files are used with the simulator to save all assignments, configurations and settings done
in the Simulator. These can be shared, so that multiple users may work with the same device
parameters. Once you make changes in the program, you can save it to the current project file
or a new project file. The type of device you select cannot be changed in the project settings; this
can only be done by creating a new project.
When you are browsing for an existing project, only VPDS files will be shown as
loadable.

CREATING NEW DEVICE
To create a new device, simply select the device you want to mimic in the welcome screen to
load its default settings and you will be brought to the IO configuration default interface.
Copyright © 2021 VPixx Technologies Inc. All Rights Reserved

LM Simulator Application Guide

10

INTRODUCTION TO THE
GRAPHICAL USER INTERFACE
The Simulator interface is designed to facilitate running experiments on a virtual VPixx device,
which will provide the same results as a real device. Once you have selected a device, the
default screen is the IO Configuration page.

Figure 7 Interface for a newly created device

<1> Device Type
<2> Analog IO Clickable Shortcut
<3> Digital Output IO Clickable Shortcut
<4> Digital Input IO Clickable Shortcut
<5> Selection of specific IO (explained below)
<6> Start/Stop Signals
<7> Port Choice: same as using buttons <2>, <3>, <4>
<8> Connected Virtual Accessory
<9> Signal Generator (refer to the Analog Input (ADC) & waveform Generator section)
Copyright © 2021 VPixx Technologies Inc. All Rights Reserved
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The main screen allows you to configure your virtual device. Each IO can be selected and
configured individually. Once you reach this screen, your virtual device is turned on, but none of
the signals are started. You must use the Start/Stop Signal button to begin. If you select an
accessory, a new tab will be shown once the signals are started, as can be seen on Figure 8.

Figure 8 RESPONSEPixx Tab

The menus at the top of the window give you access to the project management options, the
device settings and allow you to restore any closed views.

SIGNAL VIEWER
The signal viewer is a tool to preview any kind of signal sent or received by a VPixx device. If your
code generates triggers, the graph will show you the real-time states of all the inputs and outputs
of your device.
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Figure 9 Signal Viewer

<1> Zoom In/Out buttons
<2> Enable/Disable Scrolling
<3> Open the signal picker interface
<4> Save the data (or a screenshot)
<5> Device timeline
The zoom in and zoom out buttons transform your cursor into a magnifier to change the timeline
of the graph to include a smaller or bigger portion of the data. This can also be accomplished
using your mouse’s scroll wheel.
When you click on the Disable scrolling button, the graph will remain at the current time, such
that you can observe the current values. Scrolling can be enabled by pressing this button, or by
using the scrollbar and bringing it to the right of the graph (in other words, bring it to the current
time).
You can save either the full set of data recorded so far by saving to csv file (clicking on the Save

Copyright © 2021 VPixx Technologies Inc. All Rights Reserved

LM Simulator Application Guide

13

(csv) button), which will open a menu to save the file, or save only the currently shown data by
clicking on the Take Screenshot button.

Figure 10 Signal Selection

The Choose Signals button opens the Signal Selection window which allows you to select which
signals to display. At the bottom, there are shortcut to select relevant signals.
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ACCESSORY VIEWER
The accessory viewer is an interactive widget which simulates different RESPONSEPixx devices.

Figure 11 RESPONSEPixx Handheld

Every button is dynamic and can be pressed. This allows you to run an experiment and simulate
responses. The accessory viewer generates an audible noise when a button is pressed.
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DEVICE & APPLICATIONS SETTINGS
Accessed via the main menu (File -> Settings), four categories of settings currently exist:
Application, Device, Pixel Mode and Pixel Sync Mode.

Figure 12 Application Settings

The Application widget allows you to Display Pin Numbers (relevant if you want to move some
cabling to a real device). Mute all Sound disables the RESPONSEPixx clicking noises, such as not
to interfere with experience-relevant sounds.
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Figure 13 Device Settings

The Device widget allows you to give your device a Custom Device Name, control the Video
Refresh Rate (see this section) and check or uncheck the Digital Loopback Enabled box (this can
also be done via the normal API).
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Figure 14 Pixel Mode

The Pixel Mode widget lets you select the Source Display Device that will be used as a video
source for the pixel mode. You can get more information on this in the Pixel Mode section.
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Figure 15 Pixel Sync Settings

The Pixel Sync Mode widget (psync) allows you to select the Source Display Device of the pixel
(similar to pixel mode). This also reports the required pixel pattern once a psync register read or
write has been requested. It will also inform you of the Last Matching Location where the last
set of matching pixels were found, and show the Display Pixels currently from that index on the
chosen screen. For more information on pixel sync, see this section.
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DIGITAL INPUTS
ACCESSORY CONFIGURATION
VPixx devices have 24 digital inputs which are normally controlled / triggered by external
accessories or signal generators. For example, you may wish to record experiment responses or
MRI triggers to synchronize your scan to your video signal. The simulator allows you to connect
an accessory or generate waveforms which would simulate a real device connected to the digital
inputs.
The RESPONSEPixx accessory allows you to pick between the different types of available
RESPONSEPixx. Once it is selected, a new tab appears which gives you an interactive 3D model of
the chosen type.

Figure 16 Accessory Selection
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Figure 17 Properties IO Configuration
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DIGITAL PULSE / MRI TRIGGER
<1> Waveform graph: this gives you a preview of the waveform as the signal is inserted.)
<2> Signal: you select the digital pulse here.
<3> Name: allows you to name your signal, such as “MRI trigger”, or “EEG Sync”
<4> Color of the signal in the graph and the IOConfiguration.
<5> Enables or disables the signal. When your signal is enabled, the global Start/Stop signal
controls the state of this signal. If the signal is disabled, you can only start it with this button. <6>
Show or hide this specific signal in the Signal Viewer. This is connected with the chosen signals in
the graph.
<7> Period (in seconds, or hertz), which is the time for a full pulse before it repeats itself.
<8> Pulse duration: how long a signal stays high or low.
<9> High or low determines the state of this pulse for the pulse duration.
The signal allows you to create a digital output waveform. This can be used to simulate any
external equipment that would normally be sent in the digital output of a VPixx device. For
example, an MRI usually sends a 2-Hz TTL trigger which can be recorded in the digital inputs and
later be used to correlate timings of certain video events with the MRI scans.
This UI allows you to create multiple digital waveforms with all the parameters that would be
found in normal equipment: period, pulse duration and pulse behavior. In Figure 17, the period
is 0.02 second, with a pulse staying at a logical high for 0.01 second, or half of the period. This
makes it such that half of the signal is logically high and the other half is logically low.
When you disable one of the signals, you will notice that the IO Configuration widget lists it as
“Disabled” to indicate the current state. This means that nothing will be generated once the start
signal button is pressed, until you press the enable button (<5> on Figure 17).
The selected pin number relates to the pin that would be found on a real device. When using
software, we usually refer to the digital inputs using their number (such as Digital Input 3). Please
note that the pin numbers are not equal to the digital input numbers.
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DIGITAL OUTPUTS
Digital outputs can be controlled via your code, as if you were triggering external equipment.
In the UI, you can name your signal to represent its purpose. For example, you could name a
trigger sent to an EEG Recorder “EEG Trig 0”.

Figure 18 Digital Output Properties

The Show/Hide button allows you to control if you see this digital output in the signal viewer, and
the color you see here would be its color representation.
Remember that a VPixx device digital output can be controlled in multiple
ways:
➢ Set Values
➢ Schedule
➢ Pixel Mode
The pixel mode will always have precedence on the other options, then the
schedule, and lastly the values set manually. The set values can control all 24
outputs while the schedule can only control the first 16.
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PIXEL MODE
The pixel mode in the simulator has some exclusive settings. You can find the settings UI and
information in the File → Settings widget.

Figure 19 Pixel Mode Settings

Remember that Pixel mode allows you to drive the digital output by using the
color of the top-left pixel. Each color has 8 bits of red, green and blue
information and those 24 bits get translated to the 24 digital outputs.
Since the simulator does not receive any video information as would a real VPixx device, we must
use one of the computer’s display source to go get pixel values information. You should always
pick the display that will present your stimuli/pixel mode pixel otherwise you will not be getting
the digital output triggers as expected. To help make sure you have the correct display, we show
the color as well as the RGB color information of the current top-left pixel of the selected display.
The pixel mode can be activated as a normal device, or from the device menu (Device → Digital
Output)
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Once the mode is enabled or disabled from anywhere, the digital output in IO Configuration will
be updated to match pixel mode. This updates the color and the name of all the signals. Once it
is disabled, it goes back to your previous settings.

Figure 20 Pixel Mode ON
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ANALOG INPUTS AND OUTPUTS
The analog IO can be controlled via your code, as if you were sending signals to external
equipment using your standard code.
Since the analog inputs and outputs are on the same port, they can be controlled via the same
IO Configuration UI.

ANALOG OUTPUT (DAC)
For the analog output, there is no option for the signals. However, the DAC will work as a real
device with your code and they can be previewed on the signal viewer.

ANALOG INPUT (ADC) & WAVEFORM
GENERATOR
For the analog input, the options are similar to the digital inputs. You can name your signals and
generate a waveform that can simulate an external analog equipment connected to your VPixx
device. As seen on Figure 21, you have access to different waveform types as well as their period.
The available waveforms are currently a square waveform, a sinusoidal waveform, a square-saw
waveform and a triangle waveform. The period can also be modified in hertz or seconds.
The disable/enable button allows you to start the signal only when needed, otherwise it will run
until the Start/Stop signal button is pressed.
You can also use the Show/Hide button to display it easily in the signal viewer.
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Figure 21 Analog Input Properties
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AUDIO
The Simulator allows you to preview audio that would normally be played on the VPixx device’s
audio output. This requires you to perform the same steps as you would when playing audio on
a real device: send the waveform to the device’s memory, set up the frequencies and other
settings and when you send the command to start the schedule, it will be played via the Simulator
application.

DIFFERENCES BETWEEN REAL
AND SIMULATED DEVICE
In these sections, we will cover the changes or the warnings that should be followed compared
to running with a real device. The simulator was built from the idea that code running on a real
device should behave the same on the simulated device. Not everything is able to be replicated
by software, we will cover the differences.

REGISTER / MEMORY / CLOCK / TIMETAG
The register mapping of a virtual device will be the same as a real device. Some registers might
not be implemented yet because their values are not useful during experiments, but all
operations done on register are idem.
The memory is a complete copy of how VPixx devices would be filled with any data generated or
gathered on the device.
Instead of a hardware clock, the Simulator clock uses the high-precision clock from the CPU of
your computer. While some delay can be found because the software has to query the time, this
effect is rarely on the scale of seconds and most of the time it can be said to be microseconds
precise, as a real device.
This clock is used for timing all the time-sensitive mechanisms or to generate signals with the
appropriate time tags.
Markers acquiring the time of the device and similar calls require no modification;
Nothing in your code must be changed.
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SCHEDULES
Schedules will behave exactly as a real device. With the simulator, you can record mock
responses with high timing precision using the digital input log, you can send a 1-MHz digital
output waveform and verify its current state and value at any point in time, or you can send a
custom-made waveform on your DAC, for example.
Nothing in your code needs to be changed in terms of schedules.

“VIDEO” AND REFRESH RATE
Real devices will be fed a video signal which is used in a couple of function calls as well as for
some timing sequences.
The simulator does not have any video related to it and therefore it uses an internal video refresh
rate. This can be accessed in the device settings and the default value is 30 Hz.

Figure 22 Device Settings – Video Refresh Rate
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When using synchronization features triggered by the start of a video frame (refer to following
section), please note that your simulated device refresh rate is most likely lower than a real
device which usually has a default of 120 Hz.
When using features that would access the video information of the device, such as pixel mode,
we use information of a given screen as selected in the option.

VSYNC / PSYNC SYNCHRONIZATION
A quick reminder of the definition of Video Sync and Pixel Sync register reads and writes (referred
to as VSync & PSync):
➢ A register command done on VSync means that it will happen at the start of the next
video frame. At 120 Hz, this happens in the next 0.00-8.33 ms.
➢ A register command done on Psync means that it will happen when the specified
sequence of pixels given to the command is found on the screen.
VSync and Psync are critical commands when synchronizing your visual stimuli to your recorded
signals. One of the main differences between a real device and a simulated device will come from
the behavior or PSync and VSync.

There are two types of VSync and PSync:
➢ Write. A write simply sends a command to be done on the device when the criteria is
met. On a real device, a write returns instantly and the device itself hangs until the criteria
is met
➢ Update. An update sends a write request and waits until the criteria is met, then returns
updated values. An update will wait until the criteria is met.

On a simulated device, for the VSYNC, the device itself will behave like an update. The PSYNC,
on the other hand, will not block if you simply do a ‘Write’.
In the case of VSync, this means that if you do a write on VSync, it will wait until the next VSync
is received and then let your software continue. This means your stimuli will be displayed 1 frame
later than expected.
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Since no video is sent to the device, you must specify the monitor your stimuli will be presented
on for PSync:

Figure 23 Pixel Sync Mode Settings

This setting can be accessed in the File → Setting menu, under Pixel Sync Mode. This allows you
to select the monitor, but also have a preview of the current requested pixels (target pixels) as
well as the screen location of the last found pixel. The Display Pixels matches a sequence of 10
pixels as they are currently presented on the top line of the display. This sequence either starts
at the top left of the screen or at the last matching location minus one, which can also help you
debug.
Another important note for PSync: a simulated device will only look at the first line of the
selected display, while a real device will look at every pixel.

When using register updates with video synchronization (VSYNC), you must
update your code. PSYNC can be used the same way.
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LOOPBACK
VPixx devices have the possibility of enabling an internal loopback to mimic the information sent
by digital outputs to the digital inputs. This will work the same way on a simulated device. The
loopback can be enabled in the code as a normal device, as well as in the Device settings (File
→Settings → Device).
When dealing with internal loopback for testing, it is not necessary to change your code.

INTEGRATION WITH API
Our API toolbox will communicate with your simulator as they would communicate with a real
device. The only requirement is that all your software must be up to date (simulator, API and
server).
You can look at our code examples on our website or on VOCAL to see examples of experiments.

EYE TRACKER AND FUTURE
PLANS
The simulator will continually evolve during the following years. We plan on adding multiple
features including a simulation of our TRACKPixx3 eye tracker, support for multiple devices, and
much more. To stay up to date, you can see our releases by visiting: https://whatsnew.vpixx.com
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ANNEX - LICENSE MANAGEMENT
This section will help you organize your Admin accounts.
Once you purchase a (gold or silver) license, you will receive a link to create your organization’s
administrator account(s). When that account is created, you will have access to the organization
administrator webpage, found at https://my.vpixx.com/orgadmin.

Figure 24 Log In Interface to Manage Licenses
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Figure 25 Organization Administration

Your organization is the name of your lab or University. In this screenshot example, VPixx
Technologies is the organization. The Organization tab allows you to change this name.
The Entitlements section shows you the licenses you have purchased, while the Licenses section
shows you if they are currently in use and by whom.

Figure 26 The Licenses Page

INVITING NEW USERS
To give new users access to the simulator with your license in your organization, navigate to the
Group menu. Once in the group menu, click on the details of your organization. At the bottom of
the page, you will find the Add Member button, which allows you to send invitations. The invited
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person will be emailed an activation link to create their account, which will automatically be
placed in the correct group. The figures below give the relevant instructions.

Figure 27 Steps to Invite a New User
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